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Welcome to Aurora HDR 2018 
Aurora HDR is a joint project between Skylum and Trey Ratcliff to produce the most powerful, 
simple and fast HDR photo editing software in the world for Mac and PC. 

• Skylum is one of the world’s leading developers of consumer and professional photography 
software, serving Mac, Windows, and enterprise customers worldwide.  

• Trey Ratcliff is the world’s most renowned HDR photographer, with over 16 million online 
followers and over 145 billion views of his images on his website www.stuckincustoms.com, 
Google +, Facebook and other outlets. When Skylum looked to create the best HDR 
software ever, we turned to Trey to assist at all stages. 

Using Trey’s vast experience with the current tools in the market, and advanced technology from 
Skylum, we have jointly created state-of-the-art software to help photographers of all skill levels 
make amazing high-dynamic-range photos. 
Aurora HDR 2018 contains every imaginable tool needed to produce high-quality “next generation” 
dramatic images, as well as Presets and video training developed by Trey and other Pro 
photographers that will appeal to every photographer. 
__________________________________________________ 

What is HDR? 
High Dynamic Range (HDR) photography is a popular photographic technique designed to 
overcome the limitations of image sensors in digital photographs. This process utilizes multiple 
exposures of the same subject, each shot at different exposure values (“brackets”). Those brackets 
are then automatically merged into a single shot which encompasses a greater exposure range. 
__________________________________________________ 
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Key Features and Benefits of Aurora HDR 2018 
• Revolutionary HDR algorithms make possible the entire spectrum of HDR looks, from natural 

to highly stylized. 

• Total HDR editing experience with the most complete set of tools available. 

• Powerful one-click presets, including Signature Pro presets by Trey Ratcliff, Captain Kimo and 
others, yield fantastic results instantly. 

• Layers, brushes and masking provide the ultimate in selective editing. 

• Luminosity masking to blend layers 

• Unique Radiance and Glow controls and custom texture blending for creative versatility.  

• Detail enhancement to increase drama in images. 

• Extensive color and toning controls for vibrant color combinations. 

• Batch processing that auto-detects brackets. 

• Modern user interface design makes for a comfortable, understandable experience. 

• Built-in sharing supports popular photo communities and social networks. 

• RAW, JPG, TIFF and other popular files support for the greatest flexibility. 

• Workflow tailored to any style with support for using as a standalone app or as a plugin to 
popular host applications. 

• Polarizing Filter to enhance skies and areas with high-reflectivity. 

• Image Resize/Sharpen on export. 
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Key New & Improved features of Aurora HDR 2018 
There are several new features as well as improvement in Aurora HDR 2018 to help you create 
fantastic images in less time. 

User Interface / Performance 
• NEW: Tone-mapping technology with reduced noise, improved realism of initial results and 

faster performance re-written from the ground up. 
• NEW: Redesigned User Interface 
• NEW: History Panel 
• NEW: Touch Bar support for MacBook Pro 
• IMPROVED: up to 4x faster RAW image processing  
• IMPROVED: up to 2x faster merging  
• IMPROVED: 2x faster masking performance 

Editing 
• NEW: Lens Correction tool 
• NEW: Transform Tool 
• NEW: HDR Enhance (replaces Clarity ) for better sharpening and overall results 
• NEW: Dodge & Burn Filter  
• NEW: Image Flip & Rotate 
• NEW: Blend Modes  
• IMPROVED: HDR Details Boost tool 
• IMPROVED: Tone Mapping Algorithm 
• IMPROVED: RAW file handling (reveals more details in shadows/highlights, displays colors 

more accurately and reduces noise) 
• IMPROVED: Custom Texture in any layer can now be a RAW file 
• IMPROVED: Color Temperature 
• IMPROVED: Image Radiance  
• IMPROVED: HDR Structure 
• IMPROVED: Crop tool  

Open / Plug-in / Export 
• IMPROVED: Native RAW file support, including better DNG handling.  
• IMPROVED: Sharpen on export. 
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Installing and Activating Aurora HDR 2018 
There are a few ways to install Aurora HDR on your computer. The method you choose will depend 
upon how you purchased Aurora HDR. 

If Bought Directly from Skylum 
If you purchase software from our website, you’ll need to download and install your software.  
Follow these steps. 

Intall for Mac 
1. Click the download link in your activation email (sent after purchase). 
2. Locate the installer in your Downloads folder. 
3. Double-click Aurora_HDR_2018.dmg open the installer. 

4. Drag the application into your Applications folder. 
5. Choose Go > Applications to navigate to your Applications folder. 
6. Locate the Aurora HDR 2018 application and double-click to launch. 
7. Enter the email address you used when purchasing the software and your activation key 

(from your activation email) to complete installation and registration. 
8. Click Activate to launch the application.  

If you ever lose your activation key, you’ll be able to provide our support team with your email 
address and they can restore the activation code for you. You can also look up your products and 
keys at https://skylum.com/support. 
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Intall for PC 
1. Click the download link in your activation email (sent after purchase). 
2. Locate the installer in your Downloads folder. You may need to unzip the installer before 

running it. 
3. Double-click Aurora_HDR_2018.exe to launch the installer application and begin the 

installation process. 
4. Choose an installation location or use the default path. 

5. Click Install to start the installer. You may need to grant the installer permission to proceed. 
6. When the installer is complete, leave the checkbox marked for Run Aurora HDR 2018 and 

click Finish. 
7. Review and agree to the License Agreement. 
8. Enter the email address you used when purchasing the software and your activation key to 

complete installation and registration. The application is now ready to use. 
If you ever lose your activation key, you’ll be able to provide our support team with your email 
address and they can restore the activation code for you. 
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If Bought from the Mac App Store 
Mac users may also choose to purchase Aurora HDR 2018 from the Mac App store.  If you have 
done so, please follow these steps. 

1. Launch the Mac App Store. 
2. In the Search field type Aurora HDR. 
3. Locate Aurora HDR 2018 and click the Buy button. 
4. The Mac App Store may ask you to verify your ID and password. 
5. Aurora HDR is downloaded to your Applications folder. 
6. In the Finder, choose Go > Applications (Shift+Command+A) and locate the Aurora HDR 

application. 
7. Double-click on the Aurora HDR 2018 app to launch and use the application. 

If you ever delete the Aurora HDR 2018 application on your computer, you can re-download it from 
the Mac App Store. 
__________________________________________________ 

NOTE 
The Mac App Store version of Aurora HDR 2018 doesn’t offer the ability to be used as a plugin. To 
get a version that can, please contact support@skylum.com.  Just provide proof of purchase and they 
will give you a version that can be used as a plugin. 
__________________________________________________ 

System Requirements for Mac OS and Windows 
Aurora HDR 2018 Mac  

• MacBook, MacBook Air, MacBook Pro, 
iMac, iMac Pro, Mac Pro, Mac mini 

• Processor Intel 64-bit Core 2 Duo or 
better 

• Memory 8 Gb RAM or more 
• macOS High Sierra 10.13,  

Sierra 10.12.6, El Capitan 10.11.5, 
Yosemite 10.10.5 

• Hard disk 2 GB free space, SSD for best 
performance 

• Display 1280x768 size or better 

Aurora HDR 2018 Windows 
• Windows-based hardware PC with 

mouse or similar input device 
• Open GL 3.3 or later compatible 

Graphics Cards 
• Processor Intel Core i5 or better 
• Memory 8 Gb RAM or more 
• Operating System Windows 7, Windows 

8.1, Windows 10 (only x64-bit OS) 
• Hard disk 2 Gb free space, SSD for best 

performance 
• Display 1280x768 size or better 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Installing Aurora HDR 2018 as a Plugin 
While Aurora HDR is a full featured stand-alone application, some users also choose to install and 
run it as a plugin for other popular photo editing software. If you downloaded from the Mac App 
Store or choose to install as a plugin at a later time, you can easily do so. 

1. Make sure Aurora HDR is open. 
2. On a Mac, simply choose Aurora HDR > Install Plugins… or on a PC choose File > Install 

Plugins 
3. A new dialog box appears to show you which supported host applications you have 

currently installed on your computer.  

The host applications supported by Aurora HDR 2018 are: 
• Adobe Photoshop 
• Adobe Photoshop Lightroom 
• Adobe Photoshop Elements (PC support coming soon) 
• Apple Aperture (Mac-only) 

4. Click the Install/Uninstall button for the apps in which you’d like Aurora HDR to run. 
5. When finished, click Done to close the installer window. 

__________________________________________________ 

TIP 
In addition for Mac-users (though it’s not listed in this plugin dialog box) Aurora HDR will operating 
as an editing extension in Photos for Mac. This will allow you to user it on your computer as an 
additional editor within the Photos for Mac application. 
__________________________________________________ 

NOTE 
For best results, quit the host application (such as Photoshop) before you install a plugin. You may be 
prompted to input your Administrator password to complete the installation. 
__________________________________________________ 
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Using Aurora HDR 2018 with Adobe Photoshop /  
Adobe Photoshop Elements 
Aurora HDR is a powerful addition to Adobe Photoshop and Photoshop Elements. To apply Aurora 
HDR as a filter, follow these steps: 

1. Make sure Adobe Photoshop or Adobe Photoshop Elements is open. 
2. Open an image you’d like to enhance. 
3. Choose Filter > Skylum Software > Aurora HDR…  

4. A new dialog appears to indicate that Aurora HDR is running. 
5. Check the Tone Mapping box if you want to take advantage of Aurora HDR 2018’s tone 

mapping features 
6. Click the Create HDR button to process the image in Aurora HDR 2018. 
7. Make any edits or adjustments as needed in Aurora HDR.  You can use presets to speed up 

your editing workflow. 
8. When done, click the Apply button to send the adjusted image back to Photoshop. 

__________________________________________________ 

NOTE 

Aurora HDR 2018 can operate as a Smart Filter in Photoshop. If you designate 
a Photoshop layer as a Smart Filter, then launch the Aurora HDR 2018 plugin 
as normal to make edits. When you return to Photoshop you can always 
double-click on the layer and return to Aurora HDR 2018 with all edits intact. 

__________________________________________________ 
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Using Aurora HDR 2018 with Adobe Lightroom 
Images in Adobe Photoshop Lightroom can be easily handed off for editing in Aurora HDR 2018. To 
exchange a file from Lightroom to Aurora HDR 2018, follow these steps: 

1. Make sure Adobe Photoshop Lightroom is open. 
2. Choose your image(s) in Lightroom from the Library or Develop modules that you want to 

work on with Aurora HDR 2018. 
3. Choose File > Export with Preset and choose from one of two options. 

• Open original images. This option sends a 16-bit TIFF file from Lightroom to Aurora HDR 
2018 and removes any adjustments that were applied in Lightroom first. 

• Use .TIFF with Lightroom adjusters. This option sends a 16-bit TIFF file from Lightroom 
to Aurora HDR 2018 and first applies any adjustments that were made in Lightroom to the 
transferred file. 

4. A new dialog appears to indicate that Aurora HDR 2018 is running. 

5. Check the Tone Mapping box if you want to take advantage of Aurora HDR 2018’s tone 
mapping features 

6. Click the Create HDR button to process the image in Aurora HDR 2018. 
7. Make any edits or adjustments as needed in Aurora HDR 2018.  You can use presets to 

speed up your editing workflow. 
8. When done, click the Apply button to send the adjusted image back to Lightroom. A new file 

is added to your Library and stacked with the original in your Library. 

Aurora HDR 2018 User Guide Page !  of !10 98



Using Aurora HDR 2018 with Apple Aperture 
Working with Aurora HDR 2018 through Aperture is very similar to the way it behaves with 
Lightroom. To exchange a file from Aperture to Aurora HDR 2018, follow these steps: 

1. Make sure Apple Aperture is open. 
2. Choose your image(s) in Aperture from the Library that you want to work on with Aurora 

HDR 2018. 
3. Choose Photos > Edit with Plug-in > Aurora HDR 2018… or right-click on the Image and 

select Edit with Plug-in > Aurora HDR 2018.… 
4. A new dialog appears to indicate that Aurora HDR 2018 is running. 

5. Check the Tone Mapping box if you want to take advantage of Aurora HDR 2018’s tone 
mapping features 

6. Click the Create HDR button to process the image in Aurora HDR 2018. 
7. Make any edits or adjustments as needed in Aurora HDR 2018.  You can use presets to 

speed up your editing workflow. 
8. When done, click the Apply button to send the adjusted image back to Aperture. A new file 

is added to your Library and stacked with the original in your Library. 
9. When done, click the Apply button to send the adjusted image back to your Aperture 

library. 
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Using Aurora HDR 2018 as a Photos for Mac Extension 

If the version of the macOS system on your Mac is newer than 10.11 you can use Aurora HDR 2018 
as an extension to Photos for Mac. Here’s how to activate the Extension. 

1. Choose  > System Preferences. 
2. Choose Extensions. 
3. Choose Photos Editing. 

4. Select the extensions that you'd like to use.  
5. Launch Photos for Mac from your Applications folder. 
6. Choose an image to edit in your Photos library. 
7. Click the Edit Photo button. 
8. Click the Extensions button and choose Aurora HDR 2018. 
9. Make any edits or adjustments as needed in Aurora HDR 2018.  Use presets to speed up 

your editing workflow. 
10. When done, click the Save Changes button to send the adjusted image back to Photos  

for Mac. 
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Starting with Aurora HDR 2018 
Aurora HDR 2018 offers many easy-to use as well as powerful controls to adjust and improve your 
image.  The first step of course is opening a picture within the application.  

How to Open a Single Photo 
Aurora HDR 2018 can open a series of the same images shot with different exposures. A series of 
images with different exposures are commonly known as HDR brackets. Aurora HDR 2018 supports 
any practical number of images in a bracket. In addition, all versions can open just a single image 
which is great for “re-imagining” your back catalog of photos. 
How to Open a Single Photo 
There are several ways to open images based on your personal preference.  Each of these four 
methods generates the same outcome, so choose the one that works best for you. 

1. First, launch Aurora HDR 2018. 
2. You can now open a supported file format using any of these methods. 

• At the startup screen, click the Open Image button to navigate to and open a file. 
• Choose File > Open… to navigate to and open a file. 
• To open an image you recently edited, choose File > Open Recent. 
• You can also drag a photo directly onto the Aurora HDR 2018 application in the Mac OS 

Dock or Windows Taskbar. 
3. Your photo opens into a new window where you’ll need to make a few selections. 
4. Click the Settings icon (gear) to choose from two options that affect the opened file. 

• Color Denoise. Turn this option On to remove lowlight color noise when merging 
brackets.  This option is only visible if opening a raw file.  It will also increase the 
processing time for the image due to the noise removal process. 

• Chromatic Aberration Removal. Use this option to remove purple or green fringe that 
can appear along the edges of an image (especially in areas of high contrast or backlight). 
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5. Check the box for Tone Mapping if you’d like to Aurora HDR 2018 to automatically reduce 
noise, and produce a more realistic and natural initial image. This option is usually best left 
on. 

The image on the left is a single raw file that’s been opened with the Tone Mapping option.  It starts out with 
more details revealed in a natural-looking photo.  If this option is unchecked (as in the image on the left) the 
source file is opened “as-is.” 

6. Click Create HDR to open the file and begin editing. 

The Purpose of Bracketed Photos 
In order to capture all the details in a scene, many photographers turn to bracketing.  By using the 
bracketing option on a camera (or manually adjusting exposure), the photographer will capture two 
or more shots.  
The image on the left was captured 
two stops over-exposed (EV +2.0)  
to preserve details in the darker 
areas of the image.  The middle 
photo is the base exposure as 
calculated by the camera.  The 
image on the right was captured 
two stops under-exposed (EV -2.0)  
to preserve details in the brighter 
areas of the image. 

The most common number of 
exposures taken is three, in 
which a base exposure is used 
and then an under- and 
overexposed image are 
acquired to preserve the 
highlights and shadows. However, any combination of exposures to properly show the scene. The 
wider the dynamic range of the scene, the higher the number of exposures needed. If the light 
source is directly in the frame, you may need as many as seven exposures. 
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Typically these multiple exposures are taken from a tripod to ensure that there is no movement 
between each exposure.  However some users do shoot handheld and rely upon the Alignment 
option in Aurora HDR 2018 to help them align the images. When you select multiple images in a 
bracketed set, you will see a preview window with the images you plan to process as well as 
additional details about those images. 

Supported File Types 
Aurora HDR 2018 is designed to open a wide range of file formats.  This ensures compatibility with 
most cameras as well as common graphic formats.  Supported file types include: 

GRAPHIC FORMATS 

• PNG 

• JPG 

• TFF (8-bit and 16-bit) 

• PSD 

POPULAR RAW FORMATS 

• .CR2 

• .NEF 

• .ORF 

• .RAF 

• .ERF 

• .ARW 

• .RW2 

• .DNG 

• .PEF 

• and more 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Creating the Merged HDR Image 
If you have a series of bracketed photos, you can choose to merge these together for a photo with 
significantly more dynamic range.  The open dialog allows you to open your own images (and also 
includes a set of sample photos).  You can also choose to open a folder of images for Batch 
Processing (more on this later). 

1. First, launch Aurora HDR 2018. 
2. You can now open a supported file format using any of these methods. 

• At the startup screen, click the Open Image button to navigate to multiple files, select 
them, and open them. 

• Choose File > Open… to navigate to multiple files, select them, and open them. 
• You can also drag a series of photos directly onto the Aurora HDR 2018 application in the 

Mac OS Dock or Windows Taskbar. 
3. Your photos opens into a new window where you’ll need to make a few selections. 
4. Click the Settings icon (gear) to choose from three options that affect the opened file. 

• Ghost Reduction. Ghosting caused by subject movement (such as clouds blowing, trees 
swaying, or people moving). If there is a long time delay between your brackets, you may 
notice areas of high movement appear to have multiple copies of image details that 
overlap.  This option can remove these repeated details from your final photo. 

• Color Denoise. Turn this option On to remove lowlight color noise when merging 
brackets.  This option is only visible if opening a raw file.  It will also increase the 
processing time for the image due to the noise removal process. 

• Chromatic Aberration Removal. Use this option to remove purple or green fringe that 
can appear along the edges of an image (especially in areas of high contrast or backlight). 

5. Use the Alignment option if shooting handheld or if you think there might be slight camera 
movement between each shot. 

6. When ready, click Create HDR to merge the brackets together. 

Aurora HDR 2018 User Guide Page !  of !16 98



Ghost Reduction 
If there are moving objects in your HDR brackets — tree leaves, flags, people, etc. — it can look a bit 
unusual after the HDR merge process. The moving object may appear as a translucent “ghost.” This 
is simply because the image information is different on each different HDR bracket image (i.e., 
something has moved through the frame of the photo).  

The image on the left was merged without the Ghost Reduction option.  In areas of high-movement (such as 
the nets blowing in the wind) parts of the photo look unusual.  Ghosts Reduction will increase processing time, 
but should be considered for photos with lots of wind or long delays between brackets (such as low-light 
shooting). 

To minimize this problem, click the Additional Settings button which will reveal a pop-over panel 
for enabling Ghosts Reduction. This feature will let you choose a reference image from the bracket. 
The software will then analyze each of the exposures and compare it to the reference image before 
merging them into a single HDR image. The result is that any object that changed positions 
between exposures will be replaced with a static object whose position is selected from one of the 
images of the bracket.  
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Color Denoise 
This feature reduces low-light noise found in color (or “chrominance”) pixels during the merging 
process for RAW files. Access this by clicking on the Additional Settings button which will reveal a 
pop-over panel for enabling Color Denoise. 

Chromatic Aberration Removal 
This feature analyzes the merged HDR image and minimizes any chromatic aberrations which have 
been detected. These are typically characterized by a slight red or purplish glow along the edges of 
stark contrasting areas in the image. These optical aberrations however slight, are always present on 
any photo and may reduce picture quality. If you think that your image may include red or purple 
glows, click the Additional Settings button which will reveal a pop-over panel for enabling 
Chromatic Aberrations Reduction. 

Alignment 
If the photos from HDR 
bracket were taken by hand 
(e.g., without a tripod), they 
may differ slightly in 
alignment. If the Alignment 
option is checked, the 
application automatically 
aligns all the images before 
merging them into a single 
HDR image. Therefore, 
Aurora HDR 2018 makes it 
easy to use images from an 
HDR bracket series, even 
those shot without a tripod.  
If you open an image from 
an HDR bracket without Alignment, and it is slightly blurred, simply open it again with the 
Alignment option enabled. 
__________________________________________________ 

ATTENTION! 
Each of these options considerably slows down the creation of your HDR image because they 
requires significant computing resources to analyze the images. In the case of Ghosts Reduction, it is 
also worth noting that this feature may not always work properly because of a lack of information to 
obtain a single static image from a series of moving images. Keep this option off and turn it on only 
when you need to fix apparent problems with ghosting. 
__________________________________________________ 
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User Interface Overview 
Working with Aurora HDR 2018, you’ll access controls from three primary areas.  The Top Toolbar 
contains general-purpose and frequently used functions of the software.  The Side Panel is located 
to the right of the main image display; all adjustment tools, layers and the histogram can be found 
here. You can also save time with the Preset Panel which offers one-click presets at the bottom of 
the screen. 

Top Toolbar  
As you work with an image, the Top Toolbar contains many commands that you’ll frequently use.  
These are grouped logically for easier use. 

Open Images / Batch Processing Button 
The first button is a drop-down menu that controls how files are opened.  You can choose to open 
files to process one image or bracket set, or choose the Batch option to process multiple images 
using similar settings.  The batch feature is currently a Mac-only feature (but is coming to Windows 
soon). Click and hold on the button to choose between two options. 

• Open – This choice used to load new images for processing. The shortcut is Cmd+O (Mac) 
or Ctrl+O (PC). 

• Batch Processing – The second option opens up the Batch Processing dialog box. This is a 
way to process multiple images at one time. The shortcut is Cmd+B (Mac) or Ctrl+B (PC). 
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Zoom Buttons 
These next three buttons are used for changing your view of the image size in the canvas. If you 
view from left to right, the buttons do the following. 

• Zoom Level – Choose from several preset zoom levels or Fit to Screen to see the entire 
image at once. 

• Zoom Out –  This option reduces the  view size of the displayed image. The shortcut is 
Cmd+- (minus) (Mac) or Ctrl+- (minus) (PC). You can see the current zoom level at the 
bottom of the canvas. 

• Zoom In – This option increases the  view size of the displayed image. The shortcut is 
Cmd+= (equals).  (Mac) or Ctrl+= (equals) (PC). 

__________________________________________________ 
TIP 
You can also use keyboard shortcuts to control  the display of an image on-screen.  To view an image 
at its Original Size press Cmd+1 (Mac) or Ctrl+1 (PC).  This sets the image to a 100% magnification 
showing the pixels in actual size.  To see the entire image in the canvas at once, try the Fit to Screen 
command.  Press Cmd+0 (Mac) or Ctrl+0 (PC) to automatically scale a photo to fit the canvas. 
__________________________________________________ 

Comparison Buttons 
These buttons allow you to compare the original image with the original default image, so you can 
easily compare how your enhancements change the original image.  
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• Quick Preview – The eyeball icon can quickly toggle between the image originally opened 
and the current version.  Another way to see this change is to use the keyboard shortcut \ 
(backslash).  This allows you to quickly compare the current image with the original. This is 
the fastest and most convenient mode of comparison. 

• Compare Button – This button activates a comparison where the image is divided by a 
vertical strip (“curtain”). The original image (Before) is displayed on the left, and the current 
result (After) is on the right. This vertical strip can be dragged left or right, so you can view 
the differences in the picture. Another way to see this view is to use the keyboard shortcut ; 
(semicolon).   

Undo / History Buttons  
The next two buttons control the Undo command as well as let you view an image’s History.  These 
two buttons give you complete control over reverting to an earlier state of an image. 

• Undo – The Undo Button (left arrow) cancels the last action (for example, changing the 
slider). You can hold down the Option/Alt key and click the Undo button to revert an image 
to its original state. 

• History Panel – The History panel will quickly become 
an essential part of your workflow. It’s here that Aurora 
HDR 2018 keeps a list of what you have done to the 
image since you opened it. These are multiple undos 
and an easy way to go back in time.   
 
Simply click on an earlier  History State to revert the 
photo to that stage of editing.  History states are also 
saved with an image when you store it in the native 
Aurora HDR 2018 (.mpaur2) file format.  This allows for 
a nondestructive editing workflow and let’s you revert to 
an earlier version of the image. Saving the history with 
your document preserves future editing and undos, but 
can increase the file size. 
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Crop Button 
The next button activates the crop tool.  This makes it easy to change the composition of your 
image as well as a viewer’s perception of an image. You can choose to tighten the area of interest of 
an image, which allows you to de-emphasize (or even eliminate) parts of a photo and improve the 
image by better framing the subject. An additional benefit is that the crop tool can also be used to 
align (straighten) the horizon in an image it is not horizontal. We’ll discuss cropping more in a later 
chapter. 

View Preset Panel/Side Panel Buttons 
The next two buttons affect which controls are visible.  You can choose to hide options like the 
Preset Panel and Side Panel to make a larger preview image. 

• Show/Hide Preset Panel – The Preset Panel on the bottom of the Aurora HDR 2018 workspace is 
where you’ll find all of your presets.  These include those created by the Aurora HDR 2018 team as 
well as your own custom presets.  To hide the Preset Panel, just click the button to toggle visibility 
or use the Tab key to hide both the Side and Preset Panels. 

• Show/Hide Side Panel – The Side Panel on the right side of the Aurora HDR 2018 workspace is 
where you’ll find the Histogram, Layers, and Filters controls.  This area is a fixed width and is 
always displayed on the right.  To hide the Side Panel, just click the button to toggle visibility or 
use the Tab key to hide both the Side and Preset Panels. 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Share/Export Button 
The last button in the top Toolbar is used to export an image from the application and save it as a 
graphic file. The same image can also be shared with other editing software from Skylum (and 
others) or uploaded directly to social networks and other online services. 

Side Panel 
The Side panel gives you access to three important sets of controls.  The Histogram is a useful tool 
for judging exposure and details. Layers lets you work with multiple objects to create a composite 
image or to isolate effects or textures to their own place.  The Filters section gives you precise 
control over each filter you’ve added to a layer. 

Histogram /Layers / Info Buttons 
At the top of the side panel are three buttons that provide advanced controls over your images.  If 
you are just getting started with Aurora HDR 2018, you might leave these three options deactivated.  
However, as you grow comfortable with editing tasks or are looking for the most flexibility  and 
control, be sure to explore them. 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HISTOGRAM 
While color correcting or adjusting exposure, the histogram can be a great help. A histogram is a 
graphical representation of the tonal values of your image. This graph illustrates how the pixels in 
the image are distributed across brightness levels. In other words, it shows the amount of tones of 
particular brightness found in your photograph ranging from black (0% brightness) to white (100% 
brightness). Ideally, well balanced images will have tonal values across the entire range of the 
histogram. 

To read a histogram, start at the left edge, which shows the shadow regions. The middle shows the 
midtones (where most adjustments to an image are made), and to the right are the highlights.   
The histogram is able to display Red, Green, Blue channels separately or, by default, shows all of 
them at once.  Click on the Histogram to switch between seeing a composite Histogram or just 
viewing details about the Red, Green, and Blue channels (which can be useful for spotting tint 
issues and color casts). You can also see a grayscale average for luminance. 

Additionally, clicking the two small triangles in the upper left  and upper right corners will show hot 
and cold pixels respectively.  These are pixels that have shifted or exposed to become absolutely 
black or white pixels.   
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• Cold Pixels – To enable or disable the display mode of absolutely black pixels, click the 
triangle on the left and the histogram is clipped on the left side. Absolutely black pixels will 
be displayed in bright blue in the image.  Cold pixels (in blue) indicate areas where black 
has achieved maximum concentration (a zero value). 

• Hot Pixels –  Clicking the triangle on the upper right will show where your image is 
completely white, where the histogram is clipped on the right side. Absolutely white pixels 
are displayed in red. 

In both cases this can be problematic (especially for printing) as there is too much ink coverage for 
cold pixels and no details at all in the hot pixels.  These indicators are a sign that you should adjust 
the exposure of the image. You may want to leave the Histogram panel open as you work, because 
it is an easy way to learn to read the graphical details of a digital image. 
__________________________________________________ 

NOTE 
The use of the HDR Basic filter is an excellent way to take control of the Black and White points as 
well as the Shadows and Highlights of an image.  We’ll explore filters more in later chapters. Pressing 
the J key will also toggle the clipping indicators On and Off if you want to see the pixels underneath. 

__________________________________________________ 

LAYERS 
Layers are a powerful way to “build up” your images, with different enhancements and use of 
blending modes and masks on each layer. Using layers, you can apply corrections or enhancements 
on different layers, and experiment until you achieve exactly the look you’d like for your image. 

• To create a new layer. Click on the 
+ button in the Layers Toolbar 
header.  A small pop-up menu will 
appear giving you the option of 
creating a layer using one of two 
options.  
Use an Adjustment Layer to create 
a layer to which you can apply a 
preset or any other adjustment in 
the Filters panel. The Add Image 
option will show a standard Open 
File dialog, allowing you to create a 
new layer with a texture file or another image that you’ve chosen. 

• To remove the layer. Select the layer and click — in the Layers Toolbar title. 

• To change the blending mode of the layer. Set the Layer Blending mode in the drop-
down list under the word Layers or in the fly out menu indicated by the Gear icon 
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underneath the + icon. You cannot set the blending mode for the first layer because it is not 
mixed with anything - it is the baseline image. More on blending modes in the chapter 
“Working with Layers.”  

• Layer Transparency Setting. Click on the drop-down menu with percentages near the word 
Opacity. Drag the slider to customize the opacity for the selected layer.  Opacity controls 
how opaque a layer is (and is the opposite of transparency). 

• Access Advanced Settings and Functions of a Layer. Click on the Gear icon below the + 
icon. A context menu appears with additional features to apply to the layer. 

• To Change the Order of Layers. All the layers except the first are movable. Click on the 
layer and drag to move the selected layer to the new location.  Changing the stacking order 
or layers can affect the order of operation (how images are developed) which can change its 
appearance. 

• Show / Hide the Layer. Click on the eyeball on the left side of a layer to toggle between 
visible and hidden. 

You’ll learn more about layers in the chapter “Working with Layers.” 

INFO 
The Info Bar provides basic information about the file and can help you better understand your HDR 
image, as well as the zoom percentage. This information is divided into several sections and 
displays the following information (from left to right): 

• Exposure Value. The indicator of the current HDR dynamic range. This indicator shows the 
exposure value (“EV”) of the darkest bracket, then the EV of the middle bracket and finally 
the EV of the brightest bracket, each separated by an ellipses. 

• Bracket Count. The number of images used for the assembly of the HDR. 

• ISO. The ISO of the images when captured. 

• Focal Length. The focal length for the lens used when shooting brackets 

• Aperture. The ƒ-stop for the images from this bracket. 

Additional information is always shown about your image. 

• Resolution. The current resolution of the image in pixels. 

• Bit Depth. Aurora HDR 2018 operates in 32-bit per pixel mode to provide the highest 
image quality. 
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Transform & Lens Correction 
Aurora HDR 2018 offers powerful corrections to 
adjust the shape of your photo. There are many 
reasons that an image can show distortion 
including the type of lens used and the position of the camera versus the subject.  Compensating 
for these issues makes it easier to quickly straighten images and remove distractions caused by 
perspective issues or camera position. 

• Transform Tool. You can easily scale, rotate and shift your image to better fit your vision.  
This gives you full control over the position of your photo or any texture layer. 

• Lens Correction Tool. The Lens Correction tool easily fixes all kinds of lens distortion, from 
barrel and pincushion to chromatic aberration and vignetting.  This can help compensate or 
totally remove visual artifacts caused by your lens. 

You’ll learn more about the Transform and Lens Correction adjustments in the chapter “Crop & 
Transform a Photo.” 

Filters 
Filters are how you can adjust the exposure, color, contrast, and style of your image in Aurora HDR 
2018.  The proper use of filters can significantly improve your image.  Each filter is designed to 
solve specific problems or enhance an image in a particular way. The Filters section of the side 
panel contains 14 control groups which allow you to achieve the best possible image results. Each 
of the groups contain sliders and controls related to the filter. 
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AURORA HDR 2018 CONTAINS THE FOLLOWING FILTERS: 
• HDR Basic. General settings related to the Tone Mapping and compression of the image for 

the original image layer. 
• Color. Color settings such as saturation, temperature and tint. 
• HDR Structure. Adjusts the clarity, structure, micro-contrast of the image, leading to a more 

“crisp” result. 
• HDR Denoise. Reduces noise and artifacts in the image created by the HDR image merge 

process, as well as making the overall image smoother. 
• Image Radiance. Provides for an overall “dreamy” look to your image by softening image 

luminescence, and increasing contrast & saturation. 
• Polarizing Filter. Provides more color depth and cuts atmospheric haze, resulting in richer, 

bluer skies. 
• HDR Details Boost. Increases image details globally or in highlights and shadows. 
• Glow. Provides a glow effect to the image, primarily in highlights. 
• Top & Bottom Tuning. Permits separate adjustments of exposure, contrast, vibrance in the 

upper and lower areas of the image. 
• Tone Curve. Represents the tonal range of the image along a diagonal line which can be 

adjusted by clicking and dragging. May be adjusted globally or by RGB channels. 
• HSL. Adjusts the hue, saturation and luminance of a particular color channel. 
• Color Toning. Shadows and highlights color tinting for stylized visual effects. 
• Dodge & Burn. Selectively lighten or darken areas of your image with brush strokes. 
• Vignette. Provides a vignette effect for finishing images to a professional level. 

You’ll learn more about each filter in the chapter “Using Filters.” 

Preset Panel 
Houses all of the one-click Presets described in detail elsewhere in this manual. 
The Preset Panel contains all of the one-click Presets available in Aurora HDR 2018. These presets 
can be applied to any open image or to a new Adjustment layer.  To apply a preset, simply click on 
its thumbnail.  To adjust the intensity of the effect, use the Amount slider to lower the Opacity of the 
adjustment. We’ll explore presets in depth in the next chapter. 
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Working with Presets 
Presets allow you to make instant changes to your HDR image with one click of a button. Each 
preset is made up of all the saved filters as well as the settings used for each of those filters.  Presets 
can also include Blending Mode and Opacity changes made to a filter or a layer. For each layer, a 
different preset can be applied, which can make for some creative results! 

Applying a Preset 
In order to save time when developing your image, you’ll find an extensive collection of presets. 
Professional photographers from around the world have helped us create a comprehensive group 
of presets that give your images amazing enhancements in a single click. 
To apply a preset: 

1. Make sure an image is open in Aurora HDR 2018. 
2. If the Preset Panel isn’t visible, click its button 

in the Top Toolbar.   
The Preset Panel will open at the bottom edge 
of the screen. You can click the Preset Panel 
button in the Top Toolbar to toggle displaying 
and hiding the presets filmstrip bar on the 
bottom of the window. 
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3. Examine the presets available by exploring their thumbnails at the bottom of the page.  Each 
offers a live preview as what the image would look like with the Preset applied. 

4. Click on a Preset thumbnail to apply it. All the preset settings of the current preset are 
immediately applied to the image. A gold frame highlights the current preset. 

5. You can quickly switch presets by clicking on a new thumbnail. To view all the presets in a 
given category, simply use the arrow keys on your keyboard or the horizontal scrollbar 
located at the bottom of the Aurora 2018 
window. 

6. If you hover your mouse over a preset an 
Amount slider is revealed, with the default 
set to 100% opacity. By moving the Amount 
slider located within the Preset name you can 
lower the intensity that the effect has on your 
image. 

7. Click the Star icon on a preset thumbnail to 
add it to your Favorites list for easy access. 

__________________________________________________ 

TIP 
If you want to apply a preset to a new adjustment layer, click the New Preset Overlay button in the 
upper-right corner of the preset area.  This applies the preset to a new adjustment layer.  This makes 
it easy to mask the layer, adjust its opacity, or change blending modes.  This is a useful way to use 
one preset on part of the image (such as the sky) and another the rest (such as the ground).  Be sure 
to read more about masking  and blending modes for greater control. 

__________________________________________________ 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Loading Additional Presets 
There are many presets included with Aurora HDR 2018.  To make it easy to manage these presets, 
you’ll find that they are organized into several groups and categories. 

Choosing a Group 
Presets are organized into three major groups. To view these options click the Categories menu at 
the top edge of the Presets Panel.  You’ll now see several groups (as well as categories) to choose 
from, including: 

• All Presets shows you both presets created by the Skylum team as well as any that you’ve 
saved or imported. These are listed in alphabetical order. 

• Favorite Presets are the presets that you tagged with a star (just click the hollow star on a 
preset’s thumbnail). Use these presets to create a consistent edit across a series of images or 
to keep a shortlist of your 
favorite adjustments. To 
remove a preset from the 
favorite's list, click the star 
again. 

• Custom shows you presets 
that you’ve created on your 
own. 

Choosing a Category 
Presets are also organized into Categories to help sort them by style.  These categories include 
presets created by Skylum and professional photographers. To view by category, click the 
Categories menu at the top edge of the Presets Panel.  You’ll now see several categories to choose 
from, including: 

• Basic — versatile built-in presets suitable for all kinds of images. 

•  Architecture — suitable for architecture, cities, and urban landscapes. 

•  Indoor — suitable for interior shots as well as objects. 

•  Landscape — suitable to nature and landscape images. 

•  Realistic HDR — suitable for images for which a realistic style is desired. 

• Dramatic — a set of creative presets for stylized photos.  

• Trey Ratcliff Volume 1 presets — signature presets by Trey Ratcliff. 

• Captain Kimo presets — signature presets by Kim Seng (AKA “Captain Kimo”). 

•  Serge Ramelli presets — signature presets by Serge Ramelli. 
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Customizing Presets 
Remember, a preset is merely a starting point. Different photographers will desire different looks.  
Plus, a preset may work great on some photos, but need a little tweaking for others.  Once you 
select a preset, you have the ability in the Side Panel to use Filters controls to modify that preset to 
fit your specific image needs. 

Saving Custom Presets 
As you adjust presets or build your own recipes from scratch, you may find a particular combination 
that you like.  Custom presets can function as the jumping off point for your own look and style. A 
preset can store a lot of control in an easy, one-click effect. 

1. Adjust an existing preset or add your own 
effects to an image. 

2. Click the Save Filters Preset button at the 
bottom-right of the Filters controls. 

3. A dialog will pop-up at the top of the 
window asking you to name your preset. 
Give it a descriptive name to help you 
remember which situations to use the 
preset. 

4.  Click the Create New Preset button to 
store the preset. Once you've added the 
preset, it will appear in the User Presets 
group. 
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Modifying Custom Presets 
There are additional features for user presets that are not available for the built-in presets. To access 
this menu for a user preset, click the small triangle next to a preset's name while hovering over the 
preset’s thumbnail image. 

• Update with Current Settings. Overwrites or re-saves the preset with the current state of 
the sliders in the Filters controls. 

• Delete. Deletes the current user preset. 

• Rename. Renames the current preset.  

• Show in Finder. Opens a Finder (Mac) or File Explorer (PC) window for the currently 
selected preset file. This allows you to copy the preset and pass it on to someone else. 

• Export. Saves the current preset file to a location of your choice. 

Sharing a Custom Preset 
Any presets you make can be shared with other users, manually backed up to a new location, or 
copied to a new computer.  You can freely export your own presets and import another person’s 
presets into your application. 

1. To view any Custom presets simply chose File > Show Presets Folder….  Aurora HDR 2018 
presets have the file extension .maup.   

2. Select the presets you want to share, then send them to fellow Aurora HDR 2018 users. 
3. To copy presets on another machine, just choose File > Show Presets Folder… on the other 

computer. 
4. Simply drag the new presets into your Presets Folder. All presets in this folder appear in the 

Custom category and the All Presets category. 
5. For best results, restart Aurora HDR 2018 to load all the new presets. 
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__________________________________________________ 

NOTE 
You can take precise control over your Custom presets with the Show Presets Folder… command. 

• To export, you can simply copy files from this folder. 
• To import, just copy the files into the new presets folder. 
• To delete a preset, you can simply delete the preset file in the folder. 

__________________________________________________ 

Adding a Custom Preset Pack 
Occasionally Skylum or other professional photographers will release a collection of presets, called 
“Packs”.  
When you import a Custom Preset Pack, it will create a new category in the Presets category 
window, and display any associated presets therein. 
To add a Custom Preset Pack, select the menu item File > Add Custom Presets Pack. An open 
dialog will be displayed, allowing you to choose the Pack you wish to add. 
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Using Filters 
Filters are how you can adjust the exposure, color, contrast, and style of your image in Aurora HDR 
2018.  The proper use of filters can significantly improve your image.  Each filter is designed to 
solve specific problems or enhance an image in a particular way. Each major adjustment tool in 
Aurora HDR 2018 is contained within a “control group” generally consisting of a header with the 
name of the tool, along with a set of sliders or other controls related to this tool. 

An Overview Of Filters 
To help you get the most from Aurora HDR 2018’s filters, you’ll find a detailed guide below that 
explains the major features of each.  Some filters have similar controls so you may notice that 
certain Filters have parts that perform similarly. 
Common controls with every filter include the following: 

• Clicking on the header (the section name) hides and reveals this section. 

• When hovering over a name, clicking on the reset arrow returns all the sliders of this section 
are restored to their default state. To cancel this action, you can choose Edit > Undo. 

• When hovering over a name, clicking on the visibility icon (eyeball) enables or disables the 
tool, allowing you to view the image without the effect of this tool. 
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HDR Basic 
This tool gives you control to adjust the Tone Mapping process. Tone mapping (or “compression”) 
converts the wide dynamic range image into one that is more narrow and can be displayed on a 
computer monitor. It’s a great place to start your HDR journey. 

• White Balance. Use the White Balance preset list to choose from a variety of presets that are 
similar to a camera’s white balance menu. 

• Temperature. Use this slider to warm or cool a shot.  This adjustment essentially adds Cyan 
or Yellow to an image to change its color temperature. 

• Tint.  This adjusts the amount of Green or Magenta that is added to a shot.  It is useful for 
removing color casts from an image. 

• Exposure. Adjusts the global luminance of the image. Moving this slider to the left results in 
a darker image (reduction of exposure value). Moving this slider to the right results in a 
brighter image (increase of exposure value). 

• Contrast. Adjusts the contrast of the image. Contrast is the difference in luminance or color 
that makes an object in an image distinguishable from another. Practically speaking, contrast 
is determined by the difference in the color and brightness of an object in relation to other 
objects within the same field of view. 
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• HDR Enhance. The HDR Enhance slider is a single slider that adjusts a variety of controls 
including lighting effects and detail, and includes a special ability to configure balanced 
image brightness without getting completely white or completely black areas. This has the 
effect of making the image less realistic and more classically the look a lot of people 
associate with HDR. Moving the slider to the left lets you decrease the settings, achieving a 
more realistic look. 

• Smart Tone. This slider adjusts the overall brightness of image properly. When moving to 
the right, the image is more vivid, but it does not work when bright areas become white, as 
in the ordinary exposure. And when you move the slider to the left, the image becomes 
darker but there are no completely black areas. This is a very powerful and balanced image 
brightness tool. 

• Highlights. Adjusts the brightness of the brightest areas of the image. Moving the slider to 
the right cause very bright areas to become brighter, while moving the slider to the left, 
makes them darker. 

• Shadows. Adjusts the brightness level of the darkest areas of the image. Moving the slider 
to the right will cause such areas to become brighter and additional details will appear. 
When moving to the left, such areas become darker, and the number of shadow areas in the 
image generally increases.  

• Whites. Adjusts the white point of the histogram and white tones in the image. When 
moving to the right, the brightest tones will become brighter while the histogram stretches 
to the right. Moving the slider to the left will cause white tones in the image to become 
darker and the histogram to compress to the left. 

• Blacks. Sets the black point of the histogram or black tones in the image. Moving the slider 
to the right, black tones become brighter and the histogram compresses to the right. 
Moving the slider to the left, black become darker and the histogram stretches to the left. 

A recommended workflow is to start with a light touch with Exposure and Contrast, then Smart 
Tone. Then proceed to setting Shadows and Highlights and finally fine tune the contrast of the 
image using the Whites and Blacks sliders. 
__________________________________________________ 

TIP 
HDR Enhancer is the successor of traditional clarity. Just like the clarity adjustment, the new HDR 
enhancer brings out the details and textures on photo. But also takes your image much further, 
making it more sharp, vivid and eye-friendly. 
This is one of the most helpful sliders in Aurora HDR 2018 — even a subtle boost will lift almost any 
HDR photo. 
__________________________________________________ 
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Color 
The Color section gives you complete control over colors and color saturation of the image. There 
are three useful controls that each affect the colors of your image in a different way,  Be sure to 
experiment with each. 

• Saturation. Adjust the color saturation of the image. This is a standard slider, similar to many 
other applications. Moving the slider to the right will cause the colors in the image to 
become more saturated, while moving the slider to the left will cause the picture to become 
black and white. 

• Vibrance. This slider is a "Smart Saturation” control. In general, its effect is similar to 
Saturation with the difference that it increases less vibrant colors stronger and has a weaker 
effect on more vibrant colors. This allows you to get more realistic and less saturated colors 
the picture. This slider can be used in conjunction with the Saturation to enhance the 
secondary colors. 

• Color Contrast. Enhances the color contrast in the image. Color contrast specifically refers 
to contrast that is created between differences based on colors (vs. luminance). The 
strongest is, the more contrast between primary and secondary colors. 

__________________________________________________ 
TIP 
Vibrance can be used in conjunction with Saturation to make secondary colors pop a little more. 
Application of Color Contrast is also recommended to obtain realistic contrast and color saturation 
of the picture. This slider is very helpful, especially if the color temperature is incorrect — make any 
corrections here at the very start of editing, before further image adjustment is applied. 
__________________________________________________ 
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HDR Structure 
This tool allows adjusting of image 
detail and clarity. Using this tool 
you can get a classic HDR effect 
with great detail or get a smoother 
picture with less detail. This is the 
main tool to increase micro-
contrast of the image and visualize 
more details in the image. 
HDR STRUCTURE SECTION  
Increases image detail by revealing 
the structure and texture of the 
surfaces in the image. This 
enhances the image and hidden 
details appear. 

• Amount. The strength of the effect. By moving the slider to the right, the amount of visible 
detail in the image increases. Moving the slider to the left will cause the image to lose detail 
and flatten. The “zero state” in the middle means that the amount is not applied by default. 

• Softness. Controls the overall softness of structure and textures in the image. Moving the 
slider to the left will cause parts of the image to become less smooth and more unrealistic. 
This produces the so-called classic view of the HDR effect. Moving the slider to the right, on 
the contrary, the details become more global and the image is more realistic. This is very 
useful slider to adjust realistic details. 

• Boost. Adjusts the overall display of details. When moving the slider to the left, the images 
will become more realistic and “calm.” Moving the slider to the right will accentuate details 
and make the image more unrealistic. 

HDR MICROSTRUCTURE SECTION 
This section amplifies micro-detail within the image. These are small details that form the surface of 
any object in the image. They can further enhance details of the image and provide a more vivid 
artistic HDR effect, however it can also make the image very noisy. 

• Amount. Increases micro-details and contrast. 
• Softness. Affects the general "softness" and realism of the photo. Moving the slider to the 

left will cause the image to become very finely detailed and unrealistic. 
__________________________________________________ 
NOTE 
Increasing the values of detail can cause an increase of noise in the image. In case of high Clarity 
values, ghosting of the image may appear and so we do not recommend raising the value above + 
50. In most cases, HDR Detail adds a lot of noise in the image. To get a realistic HDR, do not apply 
HDR Detail. 
__________________________________________________ 
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HDR Denoise 

This tool slightly blurs the image and reduces the amount of noise and any image artifacts caused 
by merging multiple exposures together. However, special algorithms also attempt to preserve 
edge detail if possible. It can also be used to reduce the amount of noise which may have been 
caused by increasing detail within the HDR Structure section. 

• Amount. The strength of reduction of small noise in the image. Moving the slider to the 
right will increase the noise reduction. Note: the Amount slider must be moved above 0 to 
notice results. 

• Smooth. This slider allows you to make the image more blurred which has the effect of 
creating a less detailed or noisy image.  

• Boost. Adjusts the overall display of noise. When moving the slider to the right allows the 
full effect of the de-noise control to be shown. 

__________________________________________________ 
NOTE 
It’s helpful to apply this tool not to the entire image, but locally: Create a layer in which you’ll apply 
the effect, and then, using a mask, brush only the area where the effect should be applied. For 
example, if the noise is very noticeable in the sky, then, using a mask, apply the effect to the sky. This 
effect should never be applied to the entire image — otherwise too much detail will be lost. 
__________________________________________________ 
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Image Radiance 
This tool provides a soft glow effect to the image, adding more vibrant colors with an increased 
global contrast. Moderate use of Image Radiance can give you more interesting, entertaining 
“dreamy” images. 

• Amount. Effect strength. For a moderate effect and a more realistic image, keep the values 
in the Amount to +40. If the Amount value is 0, then the effect is not applied. Move the slider 
to the right to increase Amount. 

• Smoothness. Controls the softness of the effect. 
• Brightness. Controls the brightness of the effect. 
• Shadows. Controls how the affect modifies darker areas of the image. A higher value will 

brighten dark areas. 
• Warmth.  Adjusts the hue of the effect towards the warm end of the scale. 
• Vividness. A useful way to adjust the color saturation of the effect applied to the image. 

__________________________________________________ 
TIP 
At a low setting, this effect will give the image more contrast and can increase color in the image. 
Use the Vividness slider for better control. 
__________________________________________________ 
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Polarizing Filter 
On a camera, a polarizing filter can provide more color depth and cuts atmospheric haze, resulting 
in richer, bluer skies. The same holds true with the Polarizing Filter in Aurora HDR 2018.   The effect 
will produce deeper blue skies and more contrast in clouds. With a light touch of this filter, almost 
any landscape image can be improved.   

• Amount. Effect strength. If the Amount value is 0, then the effect is not applied. Move the 
slider to the right to increase Amount. 

__________________________________________________ 
NOTE 
It is not recommended to use this tool on night photos or images with no sky in them. Most times, 
keeping the effect intensity under +50 will yield the best results. 
__________________________________________________ 
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HDR Details Boost 
This filter allows you to control the details of the image, making it more clear and sharp, or vice 
versa, softer. This tool is useful for improving the overall quality of the image as well as to increase 
the quality of the images that will be used in high resolution, such as for printing. Increasing the 
sharpness can also compensate for lower quality optics used to make the captured image.  
Innovative technologies allow the HDR Details Boost adjustment to improve image sharpness 
without increasing digital noise or creating unnatural ghosting or halos in the image. This is a very 
powerful tool to improve the quality of images. 

• Small. This sets sharpness of fine details. At 0, the effect is not applied. Moving the slider to 
the right will intensify the clarity of small details, while moving to the left, on the contrary, 
somewhat washed out the fine details. 

• Medium. This sets medium-sized parts sharpness. At 0, the effect is not applied. Moving the 
slider to the right increases the sharpness, while moving the slider to the left - decreases it. 

• Large. This sets sharpness of global contours of objects in the image. At 0, the effect is not 
applied. Moving the slider to the right increases the sharpness, while moving to the left — 
decreases. 

• Protection. This slider will protect fine details from being negatively adjusted. 
• Masking is a separate slider. This slider controls the zone of detail amplification. When 

moving the slider to the left, the number of zones increases and the image becomes more 
detailed. When moving to the right, the number of granularity zones is reduced. Optimal 
masking comes from a setting in the range from 30 to 70. 
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__________________________________________________ 
NOTE 
A moderate increase in Small and Medium has positive impact on the sharpness and quality of any 
image. There is often no need to demonstrate all details in the image.  
In bright areas, such as the sky and light clouds, unnecessary detail will reduce realism. The dark 
areas often need more detail. Therefore, it is always better to strengthen Details in the shadows than 
lights. 
__________________________________________________ 
TIP 
Should you desire an image that is soft, you can achieve that effect by moving the Detail sliders to 
the left.  By default all sliders are at 0 and at that setting have no effect. The effect is only visible after 
moving sliders to the left or right. 
__________________________________________________ 
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Glow 
The Glow tool adds auras on the picture. The effect finds the brightest areas of an image and adds 
bright halos to it, having the effect of shining. This effect can be used to give the photo a "romantic" 
view or create a fog effect. This effect looks good on night photos to accentuate glow halos around 
light sources such as street or building lights.  

• Amount. Sliding this control to the right increases the strength of the glow around areas of 
high brightness. 

• Smoothness. This slider controls the size of halos around bright areas. Moving the slider to 
the right increases the size of the halos. 

• Brightness. This slider analyzes the image and determines where halos will be created, 
letting you choose those areas of brightness that should be lightened up. Moving the slider 
to the left ensures areas of maximum brightness will be selected. This locates the glow just 
around the brightest areas. Moving the slider to the right will include darker areas to glow. 
Moving it all the way to a value of 100 will light up the entire image. 

• Warmth.  By default, a neutral white color is used for the glow in the middle of a halo. This 
slider allows you to select a specific hue for the glow, according to the cool-to-warm 
spectrum shown on the slider. 

__________________________________________________ 
NOTE 
This effect can be a powerful tool for creative photo processing. When you move the Brightness 
slider to 100 and increase Amount, you get a misty or foggy effect in the picture. By increasing the 
Amount, detail in bright areas is not lost, but rather “highlighted.” 
__________________________________________________ 
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Top & Bottom Tuning 
This tool is a simulation of an 
analog filter to specify different 
brightness in the picture 
vertically - Graduated Neutral 
Density Filter. This effect is 
widely used in landscape or 
architecture photography with 
a distinct horizon. The effect 
flexibly and separately controls 
the brightness and other 
aspects of the top and bottom 
of the image.  
This enables you, for example, 
to lower the brightness of the 
sky and raise the brightness of 
the foreground. Thus, your image can be significantly improved without resorting to creating layers 
and masking. 
Note: The explanation of controls are the same for Top & Bottom sections of this panel. 

• Set Orientation. Click this button to interactively drag the position of the filter. 
• Drag the Move arrows to position the Transition Zone. 
• Place your cursor next to the Move tool and it changes to allow for Rotation of the 

Transition Zone. 
• Expand or contract the Blend handles to adjust the rate of transition from top to bottom. 

Expand the bars to increase the Blend value, making the transition between the values of 
Top to Bottom wider. Decrease the spread to decrease the blend value creating a sharp 
transition between Top and Bottom. 

• Exposure. This controls the brightness of the image. Moving the slider to the left will make it 
darker and to the right brighter. 

• Contrast. This adjusts the contrast of the image. Contrast is the difference in luminance or 
color that makes objects in an image distinguishable from another. 

• Vibrance. This slider increases less vibrant colors stronger and has a weaker effect on more 
vibrant colors. This allows you to get more realistic and less saturated colors the picture. 

• Warmth. This Adjusts the hue of the effect towards the warm end of the scale. 
__________________________________________________ 
NOTE 
This tool is best suited for landscape shooting with a strong horizon line. With it, you can lower the 
brightness of the sky at the top, and then, using Shift / Rotation / Blend orient the strip of brightness 
transition between heaven and earth approximately at the level of the horizon. 
__________________________________________________ 
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Tone Curves 
One of the most powerful tools for adjusting tones to brighten, darken, add contrast and shift 
colors. Curves can usually be applied to all channels together in an image, or to each channel 
individually. Curves can help you manually fine-tune the brightness and contrast of the image. 
Most users will either use Curves a lot or they won’t use it at all. The Curves interface is a bit 
complex and allows for up to 10 control points. This can significantly open up more options when 
adjusting color and exposure. The primary advantage of Curves is that you have precise control 
over which points get mapped for tonal adjustment. 

• Tabs. You can make a curve adjustment to all channels equally or to an individual channel 
(such as to blue to emphasize the sky). Just click on the White dot for a global adjustment or 
use the Red, Green, and Blue dot to adjust the corresponding channel. 

• Sliders. At the bottom there are sliders that let you adjust black and white points of the 
histogram (the leftmost and rightmost sliders), as well as the middle bend of the curve (the 
central slider). 

• Points. You can add up to 10 control points.  Drag up to add contrast to an area and down to 
lighten the area. Multiple points can be employed for contrast adjustments based on tonal 
range. 

__________________________________________________ 
TIP 
Many, many articles are available on the Internet for information on using this tool. Generally moving 
a slider down will darken that channel and moving it up will lighten the channel. Experiment and 
have fun! 
__________________________________________________ 

Aurora HDR 2018 User Guide Page !  of !47 98



HSL (Hue, Saturation, Luminance) 
This tool allows for separate adjustment of the hue, saturation and brightness of the main colors in 
the image. There are three tabs present in the Color Filter panel. Each tab contains sliders for Red, 
Orange, Yellow, Green, Aqua, Blue, Purple, and Magenta values. 

• Hue. A set of sliders to adjust the hue or basic color shades of your image. Sliding the 
control further to the right results in a more intense hue. 

• Saturation. A set of sliders to adjust color saturation. Sliding the control further to the right 
results in a more intense color. Of course, moving to the left removes color to the point 
where -100 will make the image appear black and white. 

• Luminance. A set of sliders to adjust the brightness of the colors. Sliding the control further 
to the right results in a brighter color within the image. The further to the left, the darker the 
image. 

__________________________________________________ 
NOTE 
This is a powerful tool for fine-tuning of colors in the image as well as a means for creative image 
processing. It is found in several other popular photo apps such as Adobe Lightroom. Examples of 
using this tool: 

• The sky is mostly blue in the photos. Therefore, lowering the brightness of blue colors in the 
image can cause more dark and deep blue of the sky. 

• Reducing the tone for some colors (move the slider to the right in Saturation tab), and leaving 
it for the other can cause a dramatic effect on the selective color in photos. 

• Raising the yellow color (move of the slider to the right) can significantly improve color 
saturation of autumn foliage on the photos. 

__________________________________________________ 
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Color Toning 
This tool affects the color toning of images. The color shade in the Highlights area is for the light 
areas in the image and the Shadows area color shade is for the dark areas. The effect can 
significantly increase the visual appeal of images, and is often used for creative artwork or to 
simulate analog photography techniques (e.g., a vintage look). 

• Amount. Controls the overall intensity of the filter. 

HIGHLIGHTS SECTION  
Sets the color for the bright colors in the image. 

• Hue. Move the slider to target the corresponding Hue that you want to modify.  

• Saturation. This slider lets you choose the saturation level of the Highlights color shade. If 
the value of saturation = 0, white is used and toning is not noticeable. Therefore, to use 
color, you must choose both Hue and Saturation. 
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SHADOWS SECTION 
Sets the color for the dark tones in the image. 

• Hue. Move the slider to target the corresponding Hue that you want to modify.  

• Saturation. This slider lets you choose the saturation level of the Shadows color shade. If 
the value of saturation = 0, white is used and toning is not noticeable. Therefore, to use 
color, you must choose both Tint and Saturation. 

GENERAL CONTROL 
• Balance. Sets the balance between light and dark tones. If you move the slider to the right, 

more tones are considered bright and therefore the color chosen for the bright areas 
(Highlights) are emphasized in the photo. Move to the left and more tones are considered 
dark and the color chosen for dark tones (Shadows) are emphasized in the photo. Thus it is 
possible to balance what color you want to have for toning the image. 

__________________________________________________ 
NOTE 
The best results are achieved if you use the opposite colors to the bright and dark areas, for 
example: yellow and blue, green and purple. 
Use warm tones for light colors and cool ones for the shadows. Only light or only dark areas of the 
image can be toned. To avoid toning of certain areas, simply set Shadows or Highlights saturation 
parameter to 0. The color is not applied. 
__________________________________________________ 
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Dodge & Burn 
Dodge & Burn tools are known as toning tools. They allow for finer control over lightening or 
darkening an image. These tools simulate traditional techniques used by photographers. In a 
darkroom, the photographer would regulate the amount of light on a particular area of a print.   

1. To Dodge and Burn, click to expand the Dodge & Burn section in the Filters list. 

2. Click the Start Painting button to open up your canvas. 

3. Choose either the Lighten or Darken tools in the top Toolbar to select the desired brush. 

4. Use the Size slider in the Toolbar to control how large the brush is. 

5. Use the Strength slider to control its impact. 

6. If you get an accidental stroke, the Erase tool can be used to remove it. 

7. Click Reset if you need to start over. 

8. Click Done to apply the adjustment. 

9. Use the Amount slider in the filter control group to further refine the global intensity of 
the filter and blend it back with the original image. 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The image on the left is the tone mapped file before applying the Dodge & Burn effect.  Using the brush 
tools, areas like the pool and sky were selectively darkened (Burn) while other areas like the foreground 
where lightened (Dodge). 

__________________________________________________ 
NOTE 
This is a tool that is meant to be used creatively and by feeling.  It is more about the looks and results 
than it is specific numbers and sliders. Feel free to experiment as you can always adjust the mask of 
the Dodge & Burn effect as well as its overall opacity. 
__________________________________________________ 
TIP 
Double click on any slider name resets the value to the default. In most cases, double-clicking 
returns it to 0. 
__________________________________________________ 
TIP 
If you press and hold the Option key and click on a slider value in the sidebar, moving the cursor to 
the left and right will let you set the values of the slider with high accuracy. Slider sensitivity is higher 
than with its normal movement. This allows you to fine-tune to small numeric values. 
__________________________________________________ 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Vignette 
A Vignette darkens or lightens the edges of your image. This is quite an old technique to emphasize 
the accents on photos. The effect typically leaves the central area unaffected while the edges are 
shaded or lightened. Aurora HDR goes further by letting you place the center point of the vignette 
anywhere in the image you like. 

• Type. You can choose to calculate if the vignette should respect cropping of the photo or 
use its original borders. 

• Amount. Strengthens the darkening around the edges of photos. In position 0, the effect is 
not applied. Move the slider to the left side of the picture to give more shading to the edges, 
while moving the slider to right will brighten the edges. 

• Size.  This is the size of the obscured area. Moving the slider to the left will increase the area 
of darkening. Moving the slider to the right will reduce the area of darkening. 

• Roundness.  This slider changes the shape of the shaded area. 
• Feather. This slider sets the smoothness of the transition between the area of shading. 
• Inner Brightness.  This slider increases the brightness in the central region which is not 

affected by shading. It allows you to create a contrast effect. 
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•Place Center Button. This control adjusts the 
center of the effect. By default, the center of 
shadowing effect is in the center of the image.  
With this button you can shift the focus from the 
center of the image to any other place.  
 
Click on the button Place center which will turn the 
cursor into a “target sight.” Click this anywhere on 
the image to set the new center of your shading 
effect. 

__________________________________________________ 
TIP 
This tool allows you to highlight key points in the photo, making it more interesting. A slight edges 
shading always provokes the viewer's eye to consider the lighter central part of the photo. You can 
also move the center to focus attention on some objects that are not in the middle of the picture. For 
a realistic picture, don’t lower the Amount below -50. As a rule, this effect is used only with darker 
shading. Highlights are rarely used except for some vintage looks. 
__________________________________________________ 

The image on the left has no vignette applied. The image on the right uses an off-center vignette to draw 
attention to the hanging chandelier. 
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Working with Layers 
Each layer can contain discrete elements of your project. Layers can contain photos, textures, ore 
adjustments. There are lots of ways to create and manage layers, but it all comes back to having an 
organized design. Be sure to double-click on the name of each layer and give it a clear, descriptive 
name to make your workflow easier. 

Using Layers 
Let’s explore using Layers. To make sure Layers are visible, do the following. 

1. Launch Aurora HDR 2018 and open 
an image. 

2. If Layers aren’t visible, click the Side 
Panel button in the Top Toolbar to 
open the panel.  You can also press 
the Tab key to open the Side Panel if 
it’s hidden. 

3. If Layers still aren’t seen, click the 
Layers button in the Side Panel to 
view Layers.  

4. Review the Layers group. When you 
first open an image, it’s named 
based on the source file.  This base 
layer can have filters applied directly 
to it or you can add more layers 
above.  Each new layer uses the 
previous layer below as it's starting 
point. In other words, each layer 
imposes the result of it's processing 
on the previous layer. 

5. To add another layer, click the + 
button at the top of the Layers 
controls.  You can add an: 

• Adjustment Layer  

• New Image Layer 

• New Original Image Layer 

• New HDR Bracket Layer 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Using the Add New Image Layer Command  

The Add Image command is a useful way to add one image on top of another in an Aurora HDR 
2018 image project.  There are many possible reasons to do this, including design and technical. In 
this chapter we’ll explore two uses for this effect 

Loading a Texture Layer 
The use of texture layers is quite a useful way to stylize an image.  You can use the Add Image 
command to place a texture above a photo. 

1. Click the + symbol at the top of the Layers panel and choose Add New Image Layer…. 
2. Navigate to a texture image on your hard drive and click the Open button to add the file to 

your document.  The layer is automatically named with the filename of the selected file. 
3. To scale the texture, right-click on its thumbnail and choose Image Mapping. 
4. Select one of the three mapping options.  You can Fit the image to the width or height, 

Scale to Fit to enlarge the image to fit the screen, or use Fill to distort the image to fill the 
screen. 

5. Click the Blend menu to change the Blending mode for the Texture layer. 
6. Drag the Opacity slider to refine the blending of the two layers. 
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As you adjust the blend mode and opacity of the texture layer, it will create many different creative 
effects. Each mode will have a different impact on your image based on the type and opacity you 
choose. Adding a texture to your image can dramatically change the look and feel of your work, 
plus you may want to use a brush to apply the texture only in specific areas of your image. 

__________________________________________________ 
NOTE 
Textures are not stored in Aurora HDR 2018. These files are located wherever you’ve saved them for 
usage. For easy access, we recommend keeping all of your textures in a consistent place on your 
hard disk. 
__________________________________________________ 
TIP 
Single View Mode, accessed from the View menu, displays adjustment controls for only the selected 
tool in the Tools Sidebar. With this viewing option, all the tools, except the current one, are closed. 
Click on a different tool and the current one will be closed and the new one opened. In this mode, 
only one control is visible, cleaning up the sidebar interface significantly. 
__________________________________________________ 
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Adding a Watermark or Logo 
A logo or watermark is an excellent way to brand an image before you post it to the Internet or 
make a print. You can use the Add Image command to place a watermark or logo above a photo. 

1. Click the + symbol at the top of the Layers 
panel and choose Add New Image 
Layer…. 

2. Navigate to a logo or watermark on your 
hard drive and click the Open button to 
add the file to your document.  The layer is 
automatically named with the filename of 
the selected file. 

3. To scale the texture, right-click on its 
thumbnail and choose Image Mapping. 

4. To prevent unwanted distortion of the 
watermark or logo, choose Fit.  

5. If the logo is over a white background, set 
it's blending mode to Multiply to blend 
the background. If the logo is over black, 
set it's blending mode to Screen. 

6. To scale the watermark, click the Transform 
Tool. 

7. Use the Scale and Rotate properties to size the logo. 
8. Use the X Offset and Y Offset to position the logo.  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Using an Adjustment Layer 
Aurora HDR 2018 offers a special type of layer that makes it easy to precisely edit your photos.  An 
adjustment layer can hold all of the filters available to you for a second instance.  You can disable 
any of the filters that you do not want to use. This is a really flexible way to work with your photos as 
it means you can easily control advanced options for filters such as their opacity, or blending 
modes.  Adjustment layers give you the most flexibility when editing a photo. 
Here’s how to work with Adjustment Layers. 

1. Open an image within Aurora HDR 2018. 
2. If hidden, open the Layers panel. 
3. At the top of the Filters section click the + button. 
4. Choose the item Add New Adjustment Layer. 
5. To make things easier, be sure to give the new 

adjustment layer a descriptive name. You can 
right-click on the layer and choose Rename to do 
this.  Type in a new name and then press the Enter 
or Return key. 

6. The new layer contains access to all of the filters. 
Adjust any of the one’s you want to modify to taste. 

7. Disable any filters you do not want to use by clicking their visibility icon (eyeball). 
8. Use advanced controls to refine the look of the filter such as the layer’s Blending Mode and 

opacity settings. Continue to add additional effects as needed to their own adjustment 
layers. 

9. As needed, you can turn layers on or off to alter the image’s appearance.  You can also drag 
adjustment layers up or down in the layer stack to generate new effects. 
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Using Blending Modes with Layers

A blending mode compares the content of two layers and enacts changes based on the content of 
both. You can choose from 14 different blending modes using the pop-up menu at the top of the 
Layers controls.  Understanding blending modes requires a bit of science.  To start let’s establish 
three key terms. 

• Base color. The original color in the image 

• Blend color. The color being applied by the top layer or Adjustment layer. 

• Result color. The color resulting from the blend 

To adjust a layer’s Blending Mode is easy. 
1. Open a photo within Aurora HDR 2108. 
2. In the Layers controls click the + button and choose the Add New Image Layer option or 

Add New Adjustment Layer. A new layer is added to your project. 
3. For the top layer, click the Blend pop-up menu in the Layers control area.  
4. Choose from one of the 14 available blending modes. 
5. Experiment with the Blending Mode and Opacity settings to create new looks. 
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Normal 
The default mode performs no additional change to how layer contents interact. 

Darken 
Pixels lighter than blend are replaced; darker ones are not. 
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Multiply 
This is similar to drawing strokes on the image with markers. The colors of the top layer or blended 
with the image. 

Color Burn 
Evaluates each channel; darkens base by increasing contrast. 
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Lighten 
Evaluates each channel; it then uses base or blend color (whichever is lighter). 

Screen 
Uses a lighter color. It is useful for “knocking” black out of a layer. 
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Overlay 
Overlays existing pixels while preserving highlights and shadows of base. 

Soft Light 
The effect is similar to shining a diffused spotlight on the image. 
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Hard Light 
Effect is similar to shining a harsh spotlight on the image. 

Difference 
Evaluates each channel and subtracts or inverts depending on brightness. 
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Subtract 
Looks at the color in each channel and subtracts the blend from the base.  

Hue 
Uses luminance and saturation of the base and the hue of the blend. 
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Color 
Preserves gray levels. It’s very useful for coloring and tinting. 

Luminosity 
Is the inverse effect from the Color mode. 
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Working with Masks 
The use of masks allow you to hide or obscure parts of an image. Masks are useful so you can 
combine the contents or results of one layer with your primary image. Layer Masks allow you to use 
powerful painting tools to selectively enhance your images. The more you work on combining 
multiple images, and editing specific areas, the more you’ll use masks.  

Creating a Layer Mask 
If you’d like to use a mask on a layer, the first step is to add one.  Any layer (even the base) can have 
a mask.  Masking the base layer blends the HDR photo with the original tone-mapped image.  
Masking additional layers blends with the images down below. 
To add a mask: 

1. Open a photo or bracket series within Aurora HDR 2018. 
2. Select the desired layer. By default, layers and adjustment layers have no mask. 
3. Click the Edit Mask icon. A new 

menu open below. The Painting 
mode makes it possible to create a 
layer mask upon which a layer effect 
will be applied. In this way, you can 
selectively edit the image. In this 
mode, the cursor turns into a brush. 
Press the left mouse button on the image to begin drawing. The toolbar contains several 
controls which we’ll explore next. 
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Painting and Erasing Masks 
Once you’ve started editing a mask, you can now add or 
subtract using a variety of tools. Remember, to edit a 
mask, click the Edit Mask button to the right of a layer’s 
name and choose a tool to use. Once you’ve chosen, a 
new toolbar appears.  Let’s explore each control. 

Global Mask Controls 
The first three controls affect a mask’s properties 
globally. 

• Visibility Icon (Eyeball).  
This controls the visibility of the mask.  It makes 
it easy to view the mask as a rubylith (red) 
overlay. You may also continue drawing while 
the layer mask is shown, for even more 
precision.  

• Mask Menu. This contains additional features 
related to operating with the layer. Clicking this 
opens a contextual menu with additional 
options for working with the layer. 

• Fill. This option attaches a mask filled with 
white that reveals all details of the filter.  Use the Brush tool to paint with black and 
subtract from the mask. 

• Invert. Inverts any mask that you’ve created so that its opacity and transparency values 
are reversed. 

• Clear Button. This option hides the results of the filter entirely.  Use the paint brush or 
gradient tools to add details back to the image. 

• Copy. Copies the current mask to the clipboard. To use this, create a new layer and paste 
it into the new layer. 

• Paste. Pastes the current mask stored on the clipboard for use on another layer. 

• Density. Controls the transparency of pixels outside of a mask so the overall the mask 
fades into the background better. 

• Feather. Blurs the edges of a mask to more naturally fade the mask adjustments into the 
image. 
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Mask Tool Controls 
The next controls affect how you can add or 
subtract from your mask.  Aurora HDR 2018 
offers four tools that you can use to paint a 
mask. 

• Brush. Use a paintbrush to add or 
subtract from your mask. 

• Radial Mask. Creates an elliptical 
shape to blend between affected and 
unaffected areas. 

• Gradient Mask. Creates a linear blend 
between affected and unaffected areas. 

• Luminosity. Creates a blended mask based on the light and dark areas of a scene.  Try out 
the Mask’s menu invert command to reverse the mask. 

Using a Brush Mask 
The first type of mask you can create is made by using a brush. Once you’ve chosen Brush from the 
pop-up list, you’ll see additional useful controls. 
The Brush can be used in either Paint mode or Erase mode to add to or subtract from areas of the 
mask. Clicking on the Paint option will add white areas to the mask.  These areas will be preserve 
the current layer.  Brushing with Erase mode is handy for “trimming” overspray of the mask and 
making your selection more accurate. 
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To control a brush, click the Brush Settings dropdown menu (it’s next to the Erase option). In this 
window, you can configure all the paint brush settings such as Size, Opacity and Softness. In the 
center of the grid there are various presets for quick selection. If you have a pen tablet attached, 
you can also configure Pen Pressure, Radius and Opacity levels. 
Here’s how to use the Masking Brush tool. 

1. Open an image or bracket series in Aurora HDR 2018. 

2. Click the Add Layer button (+ symbol) or choose Layers > Add New Adjustment Layer.  
Let’s add an obvious effect so its easy to view.   

3. On the adjustment layer, set Saturation to -100 and HDR Structure: Amount to 100. 

4. Create a Layer mask by clicking the Edit Mask button.  
You now have two options to decide how the initial mask is created. 

• Paint. Clicking with the Paint tool fills the mask with black (hiding all of its results).  As 
you paint and add strokes they are added in white.  This method allows you to brush and 
add the results of the Adjustment layer selectively. 

• Erase. Clicking with the Erase tool 
fills the mask with white (showing all 
of its results).  As you paint and add 
strokes they are added in black.  
This method allows you to brush 
and subtract the results of the 
Adjustment layer selectively.  The 
erased areas will show through to 
the image below. 

5. Click the Visibility icon (eyeball) to view the Mask. 

6. Brush with the paint tool to add the results to the layer selectively. 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7. Continue painting the mask to get the desired results.  Use the toolbar at the top of the 
window to control the behavior of the Masking Brush tool. Click the Brush drop-down menu 
to control the shape and dynamics of the brush. 

• Size. Controls the diameter of the brush.  You can also use the keyboard shortcuts [ and ] 
to make the brush smaller or larger. 

• Softness. Controls how much blending there is between the center of the brush and its 
edges.  This can create a more gradual blend on any mask.  You can also use the 
keyboard shortcuts of Shift + [ or ] to make the brush harder or softer. 

• Opacity. This controls the overall opacity in the brush.  A brush at 100% has full impact.  
A brush set to 50% will only add or subtract half of its strength. 

• Presets. In the center of the grid there are various presets for quick selection. 

• Pen Pressure. If you have a pen tablet attached, you can also configure Pen Pressure, 
Radius and Opacity levels. This allows you to draw on the tablet and have the force 
applied to the pen transfer to the size and density of the brush. 

8. Click and paint on the canvas to modify the selected mask (layer or adjustment layer). 
9. Toggle the mask visibility off by clicking the Visibility icon (eyeball) in the toolbar.   
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10. To refine the mask even more, click the Gear icon the Density and Feathering for the mask.  
This can control how the mask applies and help blend its results more. 
• Density. Controls the transparency of pixels outside of a mask so the overall the mask 

fades into the background better. 

• Feather. Blurs the edges of a mask to more naturally fade the mask adjustments into the 
image. 

11. If you choose to remove a mask, just click the Mask button in the toolbar and choose Clear 
to remove it. 
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Using a Radial Mask 
The use of a Radial Gradient Mask is a 
quick, easy way to highlight the sun, a face 
or anything else on your photo.  You can 
create an ellipse or circular shape that 
makes its easy to create a gradual blend 
between two states.  It can be used with an 
image layer to add ramping transparency.  
For an adjustment layer, it’s useful to create 
a blend between the modified and original 
state.  
Here’s how to use the Radial Mask tool 

1. Create a Layer or Adjustment Layer 
mask as previously discussed in this 
chapter.   

2. Click the Edit Mask button on the layer. 
3. Select the Radial Mask option from the Tools dropdown. 
4. Click and drag to create a circular gradient.   
5. Click the Visibility button in the top toolbar to make it easier to visualize the gradient. 
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6. The tool offers simple controls to refine the gradient. 
• Drag the middle of the gradient (the dot) to place its center. 

• Drag the inside circle’s radius to affect the size of the gradient. 

• Drag the outside circle’s radius to affect the feathering of the gradient. 

• Drag a handle on the outside circle to adjust the aspect ratio to create an ellipse shape. 

• Drag outside the outer circle to rotate the gradient mask. 

7. You can change the mode of the mask if you need to change how a mask is applied by 
clicking the Invert button. By default the Radial Gradient mask that is created will “protect” 
the center of the circle/oval and any enhancements will be applied outside of the inner 
circle. Click this button to invert the mask so that effects will be applied TO the inner circle. 

8. When satisfied with the mask, click the Done button.   
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9. If using an Adjustment Layer, adjust the Filter controls as needed.  The mask will control how 
its results are applied. If using an image layer, you can control the opacity and blending 
mode of the layer. 
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Using a Gradient Mask 
The Gradient Mask Tool is useful for creating a gradual blend between two states.  It can be used 
with an image layer to add ramping transparency.  For an Adjustment Layer, it’s useful to create a 
blend between the modified and original state. The Gradient Mask is a favorite tool of landscape 
photographers that allows you to enhance images very smoothly with effects only applied to the 
Gradient. 
Here’s how to use the Gradient Mask tool: 

1. Create a Layer or Adjustment Layer mask as 
previously discussed in this chapter.   

2. Click the Edit Mask button on the layer. 
3. Select the Gradient Mask option from the 

dropdown. 
4. Click and drag to create a linear gradient.   
5. Click the Visibility button in the top toolbar to 

make it easier to visualize the gradient. 
6. The tool offers simple controls to refine the 

gradient. 

• Drag the top bar or bottom bar to expand or contract the gradient. 

• Drag the middle dot to position the gradient. 

• Drag the bottom bar to move the end of the gradient 

• Click and drag just outside the center point to rotate the gradient mask. 
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• Drag a handle on the outside circle to adjust the aspect ratio to create an ellipse shape. 

• Drag outside the outer circle to rotate the gradient mask. 

7. When satisfied with the mask, click the Done button.   
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8. If using an Adjustment Layer, adjust the Filter controls as needed.  The mask will control how 
its results are applied. If using an image layer, you can control the opacity and blending 
mode of the layer. 

__________________________________________________ 
TIP 
You can edit the results of a Linear mask by clicking the Edit Mask button.  This lets you add or 
subtract from the mask using the Brush tool for greater control over the mask. 
__________________________________________________ 
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Luminosity Masks 
A Luminosity Mask is a fast and easy way to create a new mask based on the brightness of image 
pixels.  When selected, the command will fill the active layer with a mask based on the brightness of 
image pixels. The transparency for the layer is directly related to the brightness of the pixels. 
This command works very well to mask an overlaid image such as a cloud or texture layer. You can 
also mask a copy of a layer to enhance only part of an image. For example, if the sky and clouds are 
bright, you can create an exact mask only for that area of the image and then enhance them. 
Heres how to create a Luminosity Mask: 

1. Open a photo or bracket series within Aurora HDR 2018. 
2. In the Layers controls click the + button and choose the Add New Image Layer option. 

In this example a texture layer was added. 
3. For the desired layer, click on on the Edit Mask button and choose Luminosity. 

 A new mask is created based upon the brightness values of the image. 
4. If the mask is showing unwanted areas, you can right-mouse click on layer’s name and 

choose Invert Mask > Invert. 
5. You can also re-run the Create Luminosity Mask multiple times to generate different masks 

each time. 
6. Use the layer’s blending mode and opacity sliders to blend the layer to taste. 
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Masking Options 
Here are some extra techniques you can use when masking a layer or adjustment layer. 

• While masking or erasing, right-clicking the mouse causes a context window of parameter 
settings of the brush, and includes additional controls for pen pressure sensitivity. 

• For handy reference, in the Layers panel on the upper right side of the Side Panel, you’ll see 
a thumbnail image of the current mask. 

• To quickly switch between Paint and Erase modes, use a shortcut key X. 

• To quickly change the Diameter of the brush, use the shortcut keys [ and ]. This is very 
convenient and greatly speeds up brush work. 

• To quickly change the Softness of the brush, use the shortcut keys Shift + [ and Shift + ]. 

• If you hold down the space bar in Painting mode you can switch to Move the image mode.  
This is very convenient when zoomed in for detailed brush strokes.  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Crop & Transform a Photo 
Directly out of a camera, your digital photos will likely not be sized to the exact dimensions you 
need.  Between different shaped screens, web pages, social networks, and prints its often common 
to change the shape and size of an image. Inside of Aurora HDR 2018 you have options such as 
cropping which changes the shape of a photo, and transforming which scales the image inside the 
canvas. You can use these choices individually or in combination to achieve the desired results. 
Additionally, a photo can be transformed to counter lens issues. 

Cropping a Photo 
With the Crop tool you can change a viewer’s perception of an image. You can choose to tighten 
the area of interest of an image, which allows you to de-emphasize (or even eliminate) parts of a 
photo and improve the image by better framing the subject. An additional benefit is that the crop 
tool can also be used to align (straighten) the horizon in an image it is not horizontal.  

1. Open an image that needs cropping or straightening. 
2. Switch to Crop Tool by click the Scissors button in the top toolbar or press the C key.  

After pressing this button, the application enters Crop Tool Mode. 

3. Examine the top Info Bar which displays all functions for cropping an image. The image is 
displayed with a grid that represents the ratio chosen in the Ratio 
dropdown menu. 

4. Choose a Ratio from the Aspect dropdown menu. 
• Free – Create a custom shape by dragging to taste. 
• Original – Preserves the original shape of the photo but allows you 

to crop more tightly to remove details from the edges 
• Transposed – The original dimensions are reversed for the crop. 
• 16:10 – A ratio that matches many computer displays. 
• 16:9 – A ratio used by televisions, many electronic devices and 

presentations 
• 11:8.5 – A common size for documents. 
• 7:5 — A rectangular image that’s common for many photo sizes 
• 5:4 – A near-square image that’s common for many photo sizes 
• 4:3 – A rectangular image that’s common for many photo sizes 
• 3:2 – A rectangular image that’s common for many photo sizes 
• 1:1 – A square shaped image is created 
• 2:3, 3:4, 4:4 5:7, 8.5:11, 9X16, and 10:16 – Presets that match 

the standard print and screen ratios, but with their values 
transposed. 
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• Facebook Cover – A useful size for a page banner on Facebook. 
• Facebook Feed – A common size for an image post to Facebook. 
• Enter Custom… – Offers the ability to choose a specific aspect ratio. 

5. Choose a ratio overlay to help with cropping. 
• Rule of Thirds – This is a standard overly used to help cropping. The four intersecting 

points are considered  the best place to put a subject.  Many feel that following these 
guides makes an image appear better. 

• Phi Grid — The phi grid is similar to the rule-of-thirds grid. The difference is that the 
parallel lines are closer to each other and to the center of the frame, and the nine boxes 
are not all the same size. This grid can better accommodate the Golden Ratio.  Many 
landscape photographers feel that this is a better guide for composition rather than the 
rule of thirds.  

The Rule of Thirds overlay on the left is the default overlay when cropping. The Phi Grid on the right is an 
alternative overlay to help when cropping. 

6. Drag any of the corners or resize handles to modify the cropping rectangle. 
7. To Move the image inside the crop, just click inside the image crop area and drag to 

reposition the image “behind” the cropping rectangle. 
8. To Rotate an image you can click on the Angle readout to reveal a drop-down slider for 

adjusting the angle of the image up to 45 degrees in either direction. You can also click and 
drag just outside a corner to rotate.  A grid overlay appears to help you with accurate 
cropping. 

9. When happy with the cropping, 
click the Crop button. To cancel 
this action click Cancel.  
If you do not like the result, you 
can easily undo the cropping 
by pressing the Undo button. 
Hence cropping is a safe 
operation that can be easily 
undone. 
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Additional Options When Cropping 
Inside the Crop tool, you’ll find a few other useful commands. 

• Click the Flip button to reverse the left 
and right sides of the image. 

• Click the Flop button to reverses the top 
and bottom parts of an image. 

• Click the Rotate button to turn the 
canvas in 90˚ increments. 

Transforming a Layer 
Once you’ve merged brackets, opened a photo, or added a new layer to a document, it’s easy to 
transform it.  With the Transform tool there are many options available for changing the position, 
rotation, and scale of a layer. 

1. Open a photo or merge a series of 
brackets to create a new image. 

2. While on the base or initial Layer, click the 
Transform button near the top of the 
Filters controls. 
The image can now be transformed.  Any 
filters applied will be temporarily disabled 
while in Transform mode. 

3. Adjust any of the following properties as 
needed to transform the image: 
• Vertical. This tilts the image by 

rotating on the X-axis.  This tilts the 
image forwards or backwards and can 
help compensate for an image with 
any keystoning problems.  This type of problem causes vertical lines to appear skewed 
and is often caused by the camera shooting from age by rotating on the Y-axis.  This 
angles the image from side to side and solves the problems caused by shooting at an 
angle in relation to the subject. 

• Horizontal. This adjustment tilts the image on the Y-axis.  It can help compensate for 
perspective issues caused by shooting off-angle from your subject. 

• Rotate. Rotates the entire canvas on the Z-axis and can be useful for straightening a 
crooked photo. 

• Aspect.  This command changes the aspect ratio of a photo. Dragging the slider will 
expand the height or the width while contracting the opposite direction for the second 
value.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                

• Scale. Use the Scale command to effectively crop the transformed photo.  This is a useful 
way to hide gaps after transforming a photo. 
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• X Offset. This shifts the transformed image left or right. 
• Y Offset. This shifts the transformed image up or down. 

4. When finished, click the Apply button to use the Transform settings.  
Any filters are reenabled for the image as well. 

Aurora HDR 2018 User Guide Page !  of !85 98



Applying Lens Correction to a Layer 
The new Lens Correction command easily fixes all kinds of lens distortion, from barrel and 
pincushion to chromatic aberration and vignetting.  
This is a useful way to compensate for flaws caused 
by the lens. 

1. Open a photo or merge a series of brackets 
to create a new image. 

2. Click the Lens Correction button near the 
top of the Filters controls. 
The image can now be corrected.  Any filters 
applied will be temporarily disabled while in 
Transform mode. 

 

Aurora HDR 2018 User Guide Page !  of !86 98



3. Adjust any of the following properties as needed to transform the image: 
• Distortion. Drag to the left to increase the barrel shape of the lens.  Drag to the left to 

pinch and compensate for wider angle lenses. You may need to crop the layer or use the 
Scale command in the Transform controls to compensate for gaps at the edges. 

The image on the left shows distortion from a wide-angle lens.  On the right, some of the unwanted curvature 
has been corrected. 

• Defringe. This option is useful to remove fringe colors along edges.  This can occur 
along detailed edges in a subject, especially where there’s a sharp change in color 
values. 

• Remove CA (Chromatic Aberration). Chromatic aberration is another type of color 
fringing.  It often happens on telephoto lenses and in areas of high contrast.  It tends to 
show up as magenta or green edges. 

• Devignette. Removes any darkening at the edges of an image caused by the lens itself.   
This is a corrective command, not a stylizing command.  If you want an artistic vignette, 
use the Vignette filter. 

The image on the left shows darkening along the outer edges caused by the lens.  The image on the right has 
had its edges lightened with the Devignette command.  If you want a stylistic vignette, use the Vignette filter. 
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Saving and Exporting Files 
As you work with digital images, at some point you’ll reach a point where saving a file is a good 
idea.  It might be an in-progress save to capture work to date as you edit a photo.  Perhaps it’s to 
prepare a file for printing or sharing on the Internet.  Or maybe an export to social media.  Aurora 
HDR 2018 offers many different options for saving and exporting images to meet your needs. 

Saving a Native Aurora HDR File for Future Edits 
As you design using layers, filters, and masks… it’s a good idea to capture that work from time-to-
time. To make this easy, Aurora HDR 2018 offers a native file format, the Aurora HDR 2018 project 
file (its file extension is .mpaur2).   

1. To save your work in progress, press Cmd+S / Ctrl+S on your keyboard or choose File > 
Save….  
A new dialog opens. 

2. Choose a new location to store the saved file on your hard drive, an attached disk, or using a 
Cloud storage provider. 

3. Give the file a descriptive name. 
4. Choose the Save original resources to Document if you want to include the information 

from the brackets or source files. 
5. Choose the Save history to Document if you’d like to include the ability to undo edits that 

you’ve made. 
6. Choose the Windows compatible option on a Mac to ensure cross-platform compatibility. 
7. When finished, click Save to write the file to disk. 

Your work is saved in its current state so that you can later continue from the same point.  
The file is saved in the proprietary Aurora HDR 2018 file format and cannot be opened with 
another application. For other software to use images created using Aurora HDR 2018, you’ll 
need to Export the file (see below). 
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Exporting Images 
While saving a native Aurora HDR 2018 file is important, you may also need to export multiple files 
for other tasks.  Maybe it’s to post online, to drop into a presentation, or to collaborate with others. 
When you export a file, you can save in a variety of file formats including JPG, TIFF, PNG and even 
PSD. 

Saving an Image File 
You can also save image files from your Aurora HDR 2018 project. These files are broadly 
compatible with many other applications. To create a new graphic file. 

1. It is first suggested that you save a native Aurora HDR 2018 project first using the File > Save 
command. 

2. To create a new graphic file choose File > Export… or click the Export button in the upper 
right of the interface.  A new dialog box opens. 

3. Choose a new location to store the saved file on your hard drive, an attached disk, or using a 
cloud storage provider. 

4. Select from the following optional items: 
• Sharpen. Choose whether you 

want to Sharpen the exported file. 
This can increase details in the 
edges of the image and overcome 
some of the compression artifacts 
of formats like JPEG. 

• Resize. You can choose to export at 
the original size, or to enter a new 
dimension for the image to fit its 
long side or short side.  

• Color Space. You can choose from 
3 color spaces for output.  sRGB is 
the narrowest color gamut, but 
most compatible with the web, 
Adobe RGB is a common color 
space used in computer graphics 
and many software applications. 
ProPhoto RGB is the widest gamut 
and supports the broadest range of 
colors. ProPhoto RGB is the only 
color space that can contain all the colors captured in a raw format photo. 

• Format. Choose from eight different file formats.  Some options like TIFF and JPEG may 
offer additional settings for control over compression and bit depth. 

5. Give the file a descriptive name and click the Save button to write to disk. 
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Supported File Formats 
The following types of file can be created in Aurora HDR 2018. 

• JPEG (.jpg) – The Joint Photographic Experts Group (JPEG) format is most often used to 
display continuous-tone images (such as photos) on the Internet. Most digital cameras use 
JPEG because it provides excellent compression; the maximum setting provides 
comparable image quality to much larger file formats like TIFF. Occasionally, the print 
industry (especially newspapers) will use JPEGs. JPEG is a lossy compression, which means 
that some data is discarded during compression of the image. JPEGs should not be used as 
an archive or production file format. You should generally only save JPEG files once, 
because re-saving continues to discard data and lower image quality. If you have acquired 
an image as a JPEG in your camera, be sure to save the edited document as a native Aurora 
HDR 2018 file. 

• PNG (.png) –  The Portable Network Graphics format provides lossless compression. It is 
increasingly common on the Internet, as most web browsers support it. The PNG format was 
created to be a patent-free alternative to GIF. Its major advantage is the PNG-24 file, which 
allows for 24-bit images (8 bits per channel) and embedded transparency. It is technically 
superior to GIF. 

• GIF (.gif) – The online service provider CompuServe originally developed the Graphics 
Interchange Format (GIF). This format displays 8-bit or indexed-color graphics and images in 
HTML documents on the Internet. You’ll hear the file called both “giff” and “jiff”; both are 
acceptable. GIFs use a color table (with no more than 256 colors total, not per channel) to 
represent the image. This can lead to a small file size but also banding in the image. In most 
cases a JPEG is a better option for web delivery. 

• TIFF (.tif) – The Tagged-Image File Format is one of the most common and flexible formats 
available. It is widely used to exchange files between applications and computer platforms, 
and has a long legacy of compatibility.  Additionally, TIFF is one of the formats to work in a 
bit depth of 8 or 16 bits per channel.  

• JPEG 2000 (.jp2) – The JPEG 2000 format is an update released in the year 2000 from the 
Joint Photographic Experts Group committee.  Its intent was to replace the original JPEG 
format.  It uses a newer wavelet-based method of image compression which is more 
efficient. 

• Photoshop (.psd) – The Photoshop format is a common format used in the computer 
graphics industry.  Skylum cannot write a layered file, but can export a file that can be 
opened by Adobe Photoshop and other software packages which support the format. 
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• PDF (.pdf) – The Portable Document Format (PDF) is a file format invented by Adobe and 
was intended to be an extension of PostScript. A PDF can be viewed on virtually every 
operating system and portable media player or phone. The PDF is an open standard, which 
means that the computer industry is able to create applications that can read or write PDFs 
without paying Adobe additional fees. This openness led to the quick adoption of PDF, and 
it is utilized online extensively. 

__________________________________________________ 
NOTE 
Aurora HDR 2018 will soon support several specialty file formats unique to HDR, 
including .HDR, .EXR and Floating Point .TIF. These formats provide terrific interoperability with other 
powerful applications.  
__________________________________________________ 

Open an Image in Other Skylum Apps 
Aurora HDR 2018 is part of a bigger set of tools from Skylum. If you’re on a Mac, you can easily send 
your image to other Skylum software products for additional enhancement or correction.  Just click 
the Share Image… button at the top left corner of the 
application and choose Open In. 

• Luminar — The most powerful photo editor for 
Mac (and soon Windows). 

• Intensify CK  – Boost details and add drama. Make 
your photos stand out 

• Tonality CK —The next generation black & white 
photo editing 

• SnapHeal CK — Easily remove unwanted objects 
from photos with the world’s most advanced 
image healing algorithms. 

• FX Photo Studio CK — Stunning filters and 
photography effects for unlimited creativity 

• Focus CK — Professional filters & lens effects. 
Highlight the most important subject on your 
photo 

• Noiseless CK — The best-in-class noise reduction 
software, designed to make your noisy photos 
look their best. 
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Open an Image in other Apps or Services 
If you’d like to send your image to another application or service, that’s easy too.  Aurora HDR 2018 
integrates with several other applications and web services to make sharing your finished photo (or 
a work in-progress) fast and simple. Just click the Share Image… button at the top left corner of the 
application. Depending upon your platform, different options may be shown. 

• Mail – Attach a JPEG to a mail message 

• Messages – Send a photo as a text or instant message 

• Twitter – Add an image to your Tweet 

• Facebook – Add an image to your post 

• Flickr – A photo sharing community with free and paid memberships 

• SmugMug – An online gallery community for selling prints 

• 500px – A photo sharing community with free and paid memberships 

• Open In – You can target any application which uses Aurora HDR 2018 as a plugin or 
extension 

You may need to separately have an account on these services to access them within Aurora HDR 
2018.  If an application isn’t installed on your machine, it will be grayed out in the menu. 
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Batch Processing Files 
Batch Processing is a powerful way to open, edit and save many images at once, saving time and 
effort. The tool is ideal for working on single images as well as many sets of bracketed exposures. 
Aurora HDR 2018 will automatically group brackets based on EXIF data stored in each image 
including exposure settings, aperture settings, ISO levels, lens data and time shot. 

Getting Started with Batch Processing 
To begin a Batch Processing session, either access it from the initial Open Aurora HDR 2018 Open 
dialog, or… once the application has started from File > Batch Processing… or by clicking on the 
Batch Process button in the Top Toolbar. 

1. Load the Brackets. You can drag files or folders (which contain files) into the new window to 
load them. You can also click the Browse button in the upper right corner to bring up the 
Open file dialog. If the “Include Subfolders” option is on, and you’ve added folders, then 
Aurora HDR 2018 will search for all images in every subfolder of the added folders.  Give the 
application a little time to analyze the images. 

2. Choose a develop method. Images can be processed as single images, or as HDR Brackets. 
To switch the image processing type, you have to press the appropriate button at the 
bottom in the middle of the window.  

• HDR Brackets mode is set by default, which will automatically sort and group exposure 
brackets and process them accordingly. 

•  If the Single Images mode is selected, all the images will be treated as independent files 
and processed separately. 

3. After the images you wish to process have been selected, press the Continue button to 
reveal options and settings for Batch Processing. 
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Batch Processing Settings 
The Batch Processing feature is very versatile and contains many options that you can conveniently 
apply to a large set of images. Moving top to bottom, here are the options you have available:  

DEFAULT SETTINGS 
• Preset. The Preset panel on the left side of the window displays the Batch Processing presets 

that are available. To save current batch processing options as a preset, simply press the Add 
button at the bottom of the Preset panel and name your new preset. Thereafter, the preset 
will be saved and listed in the Preset panel. Because Batch Processing has many parameters, 
it’s helpful to create a custom preset to save time later. Note: the Batch Presets are not 
related to the image enhancement presets found in the main Aurora HDR 2018 software, 
BUT can apply an enhancement preset as part of the batch operation. 

• Save to. This option lets you choose where processed files will be saved. You can save them 
in their current location or browse to select another folder. When you’ve made a choice, the 
file “path” will be displayed. Note: Because it is possible to overwrite your original files, it is a 
good practice to save your batch-processed files into a new folder separate from the original 
files. 
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USER SETTINGS 
• Naming. Aurora HDR 2018 has very flexible file naming options. You can add a prefix and 

suffix, choose from a variety of base names and even select the case of the letters. This gives 
you tremendous flexibility to organize your files as part of the batch processing operation. 

• Format. Choose way type of file should be created.   You can make a JPEG, PNG, TIFF or 
PSD file during the batch processing. 

• Color Profile. This controls how the colors are interpreted.  Options include sRGB, Adobe 
RGB, and ProPhoto RGB 

• Resize. Easily choose a dimension for the new files. 

Advanced Settings 
If you need even more precious, be sure to try out the Advanced Settings.  Just click the Advanced 
button at the bottom of the merge window. 

• Sharpen. Enhances edge detail in the photos when merging. 
• Color Denoise.  Helps remove unwanted color noise in the image. 
• HDR Settings. The options presented here mimic the HDR Merge dialog of the main Aurora 

HDR 2018 software. These include advanced options for alignment, ghost reduction, and 
chromatic aberration cleanup. Select the settings desired by clicking the appropriate 
checkboxes. 

Click Done to store the Advanced Settings. 
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Running the Batch 
After selecting your desired Batch Processing options, click the Continue button in the lower right 
of the window to begin the operation. This will display a processing window showing progress. 

• To return to the Image Selection window and select different images prior to beginning a 
Batch Processing operation, click the Back button in the lower left of the window.  

• To cancel Batch Processing altogether, click the “X” in the upper-left corner of the window or 
the Cancel button in the lower-right. 
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Keyboard Shortcuts 

General Shortcuts 
• F  — View the current image in full-size screen. Return to the application by pressing any 

button. 

•  \  — Activates before/after comparison. When the key is pressed, the original image will be 
shown. The original image can be either the original tone-mapped result or a middle image 
in a bracket series. The last option is set by default. To change this option, simply go to the 
View > Compare With fly out menu. Releasing the key will reveal the enhanced image. 

• ; — Activates side-by-side comparison mode where the original image is on the left side and 
the edited result will be on the right side. To exit the mode press the ; button again. 

• Tab — Show/hide the Preset panel at the bottom of the window. 

• C — Enter the Crop tool. 

• G — Activates the Gradient Mask tool. 

• R —  Activates the Radial Mask Tool. 

• J — Show/hide the display of “hot” and “cold” pixels. These are completely black and white 
pixels on an image. 

• Cmd + B / Ctrl + B — Opens Batch Processing mode. 

• Shift + Cmd + E  / Shift + Ctrl +E — - Export to a file 

• Shift + Cmd + F / Shift + Ctrl + F — Show current edited file in Finder/Desktop. 

Mask Editing Shortcuts 
• [ — Decrease the brush radius 

• ] — Increases the brush radius 

• Shift + [ — Decreases the brush softness 

• Shift + ] — Increases the brush softness 

• X — Switches between Paint and Erase modes 

• Cmd + I / Ctrl + I — Inverts the layer mask 

• / —  Show current layer mask in the form of red transparent image imposition 

• Spacebar — Pans the image in the painting mode when zoomed in.  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Keeping Aurora HDR 2018 Up to Date 
Aurora HDR 2018 has a handy automatic update feature to address updates, new features, 
enhancements and bug fixes. To ensure you’ve got the latest release, open the software and choose 
the Aurora HDR 2018 > Check for Updates (Mac) or Help > Check for Updates (PC). 
This will launch the Skylum update service and automatically grab any updates you need. Follow 
any prompts relating to installation and/or restarting the software. You may also need to input your 
Administrator Password and update the Plug-ins for your other applications. 

 

Thank you.  

If you have questions, contact Aurora HDR 24/7 support at support@aurorahdr.com.  
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